Making Everything Easier!”

photoshop
Elements 13

DUMMIES

Learn to: ' ‘ k

* Quickly correct common problems ) .
like flat contrast and dull color - '

» Add an artistic touch with filters
and effects

« Create prints, slide shows, and
photo books

IN FULL COLOR!

Barbara Obermeier

Author of Photoshop All-in-One For Dummies

Ted Padova

Recognized authority on Adobe Acrobat
and digital imaging




Get More and Do More at Dummies.com®

\ Start with FREE Cheat Sheets
(/)
Cne

X Cheat Sheets include

"\\"0 « Checklists
« Charts
« Common Instructions
« And Other Good Stuff!

To access the Cheat Sheet created specifically for this book, go to
www.dummies.com/cheatsheet/photoshopelements

¥ .

Get Smart at Dummies.com
Dummies.com makes your life easier with 1,000s

of answers on everything from removing wallpaper
to using the latest version of Windows.

Check out our
«Videos
« lllustrated Articles
« Step-by-Step Instructions

Plus, each month you can win valuable prizes by entering
our Dummies.com sweepstakes. *

Want a weekly dose of Dummies? Sign up for Newsletters on
« Digital Photography
« Microsoft Windows & Office
» Personal Finance & Investing
+ Health & Wellness
« Computing, iPods & Cell Phones
- eBay
+ Internet
« Food, Home & Garden

Find out”“/HOW” at Dummies.com

*Sweepstakes not currently available in all countries; visit Dummies.com for official rules.


http://www.dummies.com/cheatsheet/photoshopelements

Photoshop
Elements 13

DUMMIED

by Barbara Obermeier
and Ted Padova

DUMMIES



Photoshop® Elements 13 For Dummies®
Published by: John Wiley & Sons, Inc., 111 River Street, Hoboken, NJ 07030-5774, www.wiley.com

Copyright © 2014 by John Wiley & Sons, Inc., Hoboken, New Jersey
Published simultaneously in Canada

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form
or by any means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as
permitted under Sections 107 or 108 of the 1976 United States Copyright Act, without the prior writ-
ten permission of the Publisher. Requests to the Publisher for permission should be addressed to the
Permissions Department, John Wiley & Sons, Inc., 111 River Street, Hoboken, NJ 07030, (201) 748-6011,
fax (201) 748-6008, or online at http://www.wiley.com/go/permissions.

Trademarks: Wiley, For Dummies, the Dummies Man logo, Dummies.com, Making Everything Easier, and
related trade dress are trademarks or registered trademarks of John Wiley & Sons, Inc. and may not be
used without written permission. Photoshop is a registered trademark of Adobe Systems Incorporated.
All other trademarks are the property of their respective owners. John Wiley & Sons, Inc. is not associated
with any product or vendor mentioned in this book.

LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY: THE PUBLISHER AND THE AUTHOR MAKE NO
REPRESENTATIONS OR WARRANTIES WITH RESPECT TO THE ACCURACY OR COMPLETENESS OF
THE CONTENTS OF THIS WORK AND SPECIFICALLY DISCLAIM ALL WARRANTIES, INCLUDING WITH-
OUT LIMITATION WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE. NO WARRANTY MAY BE
CREATED OR EXTENDED BY SALES OR PROMOTIONAL MATERIALS. THE ADVICE AND STRATEGIES
CONTAINED HEREIN MAY NOT BE SUITABLE FOR EVERY SITUATION. THIS WORK IS SOLD WITH THE
UNDERSTANDING THAT THE PUBLISHER IS NOT ENGAGED IN RENDERING LEGAL, ACCOUNTING, OR
OTHER PROFESSIONAL SERVICES. IF PROFESSIONAL ASSISTANCE IS REQUIRED, THE SERVICES OF
A COMPETENT PROFESSIONAL PERSON SHOULD BE SOUGHT. NEITHER THE PUBLISHER NOR THE
AUTHOR SHALL BE LIABLE FOR DAMAGES ARISING HEREFROM. THE FACT THAT AN ORGANIZATION
OR WEBSITE IS REFERRED TO IN THIS WORK AS A CITATION AND/OR A POTENTIAL SOURCE OF
FURTHER INFORMATION DOES NOT MEAN THAT THE AUTHOR OR THE PUBLISHER ENDORSES THE
INFORMATION THE ORGANIZATION OR WEBSITE MAY PROVIDE OR RECOMMENDATIONS IT MAY
MAKE. FURTHER, READERS SHOULD BE AWARE THAT INTERNET WEBSITES LISTED IN THIS WORK
MAY HAVE CHANGED OR DISAPPEARED BETWEEN WHEN THIS WORK WAS WRITTEN AND WHEN
IT IS READ.

For general information on our other products and services, please contact our Customer Care Department
within the U.S. at 877-762-2974, outside the U.S. at 317-572-3993, or fax 317-572-4002. For technical support,
please visit www.wiley.com/techsupport.

Wiley publishes in a variety of print and electronic formats and by print-on-demand. Some material included
with standard print versions of this book may not be included in e-books or in print-on-demand. If this book
refers to media such as a CD or DVD that is not included in the version you purchased, you may download
this material at http://booksupport .wiley.com. For more information about Wiley products, visit
www.wiley.com.

Library of Congress Control Number is available from the publisher.

ISBN 978-1-118-96464-4 (pbk); ISBN 978-1-118-96465-1 (ebk); ISBN 978-1-118-96470-5 (ebk)
Manufactured in the United States of America

109 87654321


http://www.wiley.com/
http://www.wiley.com/go/permissions
http://www.wiley.com/techsupport
http://booksupport.wiley.com/
http://www.wiley.com/

Contents at a Glance

JAEFOAUCEION .........eeeeeeaaaaacaaaaaaaaannnnnnneaaeeeeeeeeeeeaaaaaaann ]
Part I: Getting Started with Photoshop Elements 13 ....... 5
Chapter 1: Getting Started with Image Editing ..........ccoceverviiiinniniiniininenieeeeee 7
Chapter 2: Basic Image-Editing CONCEPtS .......cccuevierienieiiriiieiecieciestesee e 25
Chapter 3: Exploring the Photo Editor..........cccooiiiiiiiiiiieeeeeeeeee 55
Part 11: Managing Media..................cccueeeueeeeeeeeenennnnnas 79
Chapter 4: Navigating the Organizer ............ccocevvevieveririeiieeneseeeeeeee e 81
Chapter 5: Organizing YOUr PiCtUTes.........ccccevievieiieniieieieieteeseceeeeeeee e 99
Chapter 6: Viewing and Finding Your Images .........cccoeveeverciiniiiniiencienienieneeseesieenne 121
Part 11]: Selecting and Correcting Photos................... 139
Chapter 7: Making and Modifying Selections............cccecivieiiiininenenceeneeeee 141
Chapter 8: Working with LaYers .........ccccceviriririienieeieeeceeeese e 171
Chapter 9: Simple Image MaKEOVETS ........ccceeiiviiniinieniieieeieeieereete st saeesaeenee 193
Chapter 10: Correcting Contrast, Color, and Clarity.........c.cccecceevverciencenvenveenieenennne 227
Part IU: Exploring Vour Inner Artist.........cceeeeeeeeeeennens 259
Chapter 11: Playing with Filters, Effects, Styles, and More............ccceceecieviineniennnnne. 261
Chapter 12: Drawing and Painting ...........ccccoceeieeienienenineeeeeeeseeeeeeee e 299
Chapter 13: Working With TYPE ......ccecviriiriiieieeeeeeeeeeee et 325
Part U: Printing, Creating, and Sharing..................... 345
Chapter 14: Getting It ON PaAPEer .......c.cccviviiiiiiiiietceeeeeeeeeetese s 347
Chapter 15: Sharing YOUr WOTK ........ccccooeiiiriiiiniieeeeteeeeee e 363
Chapter 16: MaKking Creations ...........ccccevererierieienienenieseeeeteeesee e ssesseeeessessessesseenes 379
Part Ul: The Part of Tens ........cccccacacaaecrceeeeeeeeeeeeeeeens 391
Chapter 17: Ten Tips for Composing Better Photos........cccccovvvvvienciinciniiniiiniienne 393
Chapter 18: Ten More Project [d€as.........ccceevevieniinieniesiicieeieereeeeste e e e 399






Table of Contents

JNtrodUCHionN ...........ceneeeeeeeeeeeeeeneeacenacenceacencennconceacenncanee |

ADOUL THiS BOOK .....cvvviiiiiiiiiiceiee ettt et ceaan e ens 1
Icons Used in This BOOK ..........coovuiiiiiiiiiiieiiieceeee e 2
Beyond the BOOK .......ccoooiiiiiiiiiiieieetetet ettt 3
Where to GO from HETE..........ooovvieeiieeeeeeeeeeeeeeeeeeeee e 3

Part I: Getting Started with Photoshop Elements 13........ 5

Chapter 1: Getting Started with Image Editing..................... 7
Launching the Photo EQitOr ..........cooceiiiiiiniiniiiececeeeeeee 7
Making Basic Edits in Quick Mode .........ccccoooiiviiniiniiniiicienieeieeieneeneenne 9
Sharing @ PROtO......ccuiiiiicececeeeceeeee et 12
Creating Images from Scratch.........cccooooiiriiiiiiiie 14
Retracing YOUY StEPS ....cceecieiiiiiieieeieeiestestese ettt aa e ae s 17

Using the History panel..........ccccocirviiniienienienieneeecieeeeeeeeesee e 17
Reverting to the last SAVEe ........cccevvvviiriiiniiniieeceeee e 18
Getting a Helping Hand ...........oocooviiiiininniniinieneteeteteeeeeee 19
Saving Files With PUIPOSE.........ccoccvieiiiiicieceeeeeeeeeeee e 21
Using the Save/Save As dialog DOX........ccccoceviririieienenenineeeeiene 21
Saving files for the Web .........cccocieviiiiieiiciiceeee e 23

Chapter 2: Basic Image-Editing Concepts........................ 25

Grappling with the Ubiquitous Pixels .........cccccceevirviieviencinieeieceeeeeeene, 26
Understanding resolution...........cocevveevierieniienieneeneccieeieeeeeee e 27
Understanding image dimensions .........c.ccecevieneenerniensiensienseeneenne 30

The Art of Resampling .........ccccoevevvieniiniiiniiniicciecececeete e 30
Changing image size and resolution............ccccceeeveecieecieeciiceeeeeeenne, 31
Understanding the results of resampling .........ccccoccevevevenencenniennns 33

Choosing a Resolution for Print or Onscreen..........cccceeeveevenieneeneenneennen. 34

Go Ahead — Make My Model..........ccoevieriieieicieieeceeeeeeee et 35
Converting to Bitmap mode ..........ccoceeveviiiininnenniiiienienieeeeeeeeeeen 36
Converting to Grayscale mode..........ccccceceevernierrieriiennieniienieneeneenes 38

Understanding File Formats .........cccooeeeciieiiicciieeccecceeceeeee e 42
File formats at a glance ..........cocoveeiririieieniee e 47
Audio and video formats supported in Elements.............cccccueneenn. 49

Getting Familiar with COlOY ........cccviiiiiiiiieiicieeeeeeeee e 49

Getting Color Right.......ccccveiiiiiiicieeee et 51
(070] (o) G 13 LSl ST 1) VAR 7 PR 51

Calibrating your monitor ............ccceeevevieriienieneeecre e 51



Ui Photoshop Elements 13 For Dummies

Choosing a cOlor WOTKSPACE .......ccevuiemieiiiinieieeieeteieiesie e 52
Understanding how profiles Work ..........ccccovniiniiiiininninniens 53
Chapter 3: Exploring the Photo Editor. ........................... 55
Examining the Photo Eitor ...........ccoccveviiiiicicieeeeeeeeeee e 55
Examining the image Window...........ccecevienieniinieneeieneeeeeeeeee 59
Uncovering the contextual Menus.........ccccoeceeveenienernieniennenieneee, 63
Selecting the tOOlS .......cocevviiiiiiiirii e 63
Selecting from the Tool Options..........ccccceveviririienierereceeceeeeeens 66
Playing with panels..........ccccevieiieiiiiiiceceeeeeeee e 66
Using the Photo Bin.......ccccooiiiiiiiieieciecccceeceeeeeeveete et 69
Creating different views of an image..........cccoeceeeveecierviiriencienieneenne, 69
Viewing filenames ..........cocevieveiiiniinnienieetesiesest et 70
Using Photo Bin ACHIONS .........ccceeieiririeieeeeeeeeeeeeeeeeeens 70
Finding Your Bearings in Guided Mode..........c.cccccererirercinnienineneneeenenn 71
Controlling the Editing Environment .............coccoceviniinininnininenenceeeee 73
Launching and navigating preferences.........c.cccoceeeevierciiecienciennenne. 74
Checking out all the preferences panes.........cccceeeevviervenvienceennenne. 75
CustomizZing PreSets.....c.ccoviiviiniiiiiiieiececcceeeee et 77

Part 11: Managing Media................ccccueeeeeeeeeeeeeeeennnnnnas 79

Chapter 4: Navigating the Organizer............................. 81
Organizing Photos and Media on a Hard Drive .........ccccccoecvevvvinieneenneennen. 82
Adding Images to the Organizer ..........cccceceevieviinienieneeneeeeeeeeeeeeees 83

Adding files from folders and removable media...........ccccoeeuennnenns 83
Downloading camera images with the Elements Downloader....... 85
Importing additional photos from folders...........ccccocervirneniencnnne. 87
Getting photos from iPhoto (Mac only)........ccccecevevininenencnienene. 88
Navigating the Media BrOWSET .........ccccccueviirieneeiieiieiecieeteeee e 89
USING @ SCANMET ......ccutiiiiiieiiiiieieeieetestest ettt ebeesbeetestesaesaesaaesseeneees 90
Understanding image requirements..........coccoeveereererviensienseenseeneennes 91
Using scanner plug-ins (Windows) ........ceceeveeriinennennienniennieneeneenes 92
Scanning on the MAC ........cccveveeciieiieieceeceeseeee e 93
Scanning many photos at a time..........cccccceevenienieceeciiceeeeee 94
Phoning in Your IMages.........c.ccvoeeieieiiiniceeeeeeeeee ettt 95
Setting Organizer Preferences ...........ccoccovvevienieninniinnieccienieeieceeeceseeen 97

Chapter 5: Organizing Your Pictures. .......................o..e. 99
Touring the Organizer...........cccovvieevieriieriienierieeeeeie et 99
Organizing Groups of Images with Tags .......ccccoccevverieniiiniiniienienecens 103

Creating and viewing @ tag.........ccoceeveeviernierniennienienieneesieeeeseeseens 103

Adding iCONS 10 tAGS ...veevereiriieieieiereeeetete ettt 105



Table of Contents
Working with custom tags ........cccecveevieecieecieccieeieceeceeeeee e 106
Working with default tags........cccccoeieviieiiinciiniicieeeeeeeeeee, 108
Working with subcategories..........cccoovvvierviirciinciiniienicecceeeeeen 109
Sorting photos according to tags.......ccceevvevienieneenensenienienienene 109
Rating Images with Stars ........ccoccevveeiiniiniineeeeeeeee 110
Adding Images to an AIDUIM .........ccceeeiieiieeieeieceeceeceee e 111
Creating an albUm.........oocoviriiririieieeeeeeeee e 112
Using albums for temporary Work.........cccccecvevveeneenieenenciencieneennnens 113
Editing an album .........ccooieviiiieiiniiiiceicecseee e 114
Finding out more about sharing your albums.........cccccccoevueruennn. 114
Adding People in the Media Browser..........ccccceceevieniininnensensienienienens 115
Placing Pictures on Maps ........cceecveeienienienieseeeteesre e eeeeeesee e seesseenns 116
Working wWith EVENtS .......ccccciiiiiiiieiicicececeeeeteeee e 118
Chapter 6: Viewing and Finding Your Images.................... 121
Cataloging Files ......c.cooiviiiiiieeeeeee et 121
Using the Catalog Manager ...........c.ccceevueeieneeneeneeneenieeieereevesnens 122
Working with catalogs.........cceeeeviiiiiiiniiniiriiciicieeececeeeee e 123
Backing up your catalog......cc.ccecevviirierienienienieeneesieeiesie e 124
Backing up photos and files (Windows) .......ccccoeceeverviervieniieneenncnne 126
Switching to a Different VIEW .........cccocvevieviiininieieeeece e 126
Viewing Photos in a Slide ShOW ........cccoooiiiinininiiieeeeceeee 127
Searching for PROtOS........cccvviiiiiieieciececeteeeeeeeeee e 129
USING SEATCH ..c..eiiiiiieicteeeeeeee et 130
Searching for untagged items.........c.cceevuevieniinienienieneneeeeieene 130
Searching captions and NOtES ..........ccoecueveeviiniinennenienerieeeeene 130
Searching by hiStOry........cccoveviecieciiiieceeeeeeeee e 131
Searching metadata..........coceveeirieiienenirieeeeeee e 131
Searching similariti€s .........ccocceeeeeriiiiieriieniececeeeeeee e 133
Grouping Files That Get in the Way .......cccocevviiiiniiniiinieceeceeceeee 135
Marking files as hidden ............ccccevvevieeinieceeieeeceeeeeee e 135
STACKING "IN UP «.evveeviieeiieieiesieeeecetestesie e s eetessessesneeaessessessnns 135
Creating VErSIONS .......ccccveeieeiieitiecieceecie et esteeaeeae e sreesaeesaeseeans 137

Part 1l1: Selecting and Correcting Photos.................... 139

Chapter 7: Making and Modifying Selections ................... M
Defining SeleCtions ........ccccevveriiiiiiriieeiertertetee et 141
Creating Rectangular and Elliptical Selections...........cccccovveeriinienennennne 142

Perfecting squares and circles with Shift and Alt
(Option on the Mac) .....ccceeeeiiienierieeeeeeee e 143

Applying Marquee Options ..........ccceecveevierieeienieneeseeseeseeseesae s 144

vii



UIII Photoshop Elements 13 For Dummies

Making Freeform Selections with the Lasso Tools..........cccceceveevieniennne. 146
Selecting with the Lasso toOl...........ccceecveeieiiiniineeseeeeeeeeieene 147
Getting straight with the Polygonal Lasso tool...........ccccccueeuenen. 148
Snapping with the Magnetic Lasso tool..........cccoceevevviriiinvienceennnnn. 149

Working Wizardry with the Magic Wand...........cccceevvvevenenccncieceeeenene 152
Talking about Tolerance...........cccecuvecieeieeeeneenieceeceee e 152
Wielding the Wand to select.........ccoeceeeieeieiiinieeieeeeceeeeee, 153

Modifying Your SEleCtions ..........ccccveveevierieniieieieieieieste e 154
Adding to, subtracting from, and intersecting a selection........... 154
Avoiding Key COLlISIONS .......c.ccveeverieriirieieeeieieseee e 155

Painting with the Selection Brush ...........ccccovevieiiriiiinenieeeee 156

Painting with the Quick Selection ToOL..........cccccvevieviecieeciieiecieeeeeeae 158

Fine-Tuning with the Refine Selection Brush ...........ccocoovniiiiiinnnnne 160

Working with the Cookie Cutter TOOl .........cccceevevierienieciecieeiecieeeeeene 161

Eliminating with the Eraser TOOIS ........cccocevienirniiriiniecieciecieeeeeeeeee 163
The Eraser t0O0L......cocooiiiiiiiniiiiiiicieceteeet e 163
The Background Eraser tool...........coccevvieviiniiniininnenienienienieeene 164
The Magic Eraser tool ........cccoccvevrinennineneincnccneneceseneeeeeenee 165

Using the Select MENU........c.cccieeiieiieeiienieeieceeseeste et esreeveeeeseesaesseesaeenns 165
Selecting all or NOthing ........cccecieiiiiiiriecieeeeeeee e 166
Reselecting a selection.........ccccecevviiiiinienienieeeeeeeeeeeeeee e 166
Inversing a SeleCtion.........coceeveeviiriiiiiienierieeet e 166
Feathering a selection .........ccoccovevviiiiinieniiniiieccceeeeee 166
Refining the edges of a selection ...........c..coccocveviiininininicncncnene 167
Using the Modify commands............ccceceeierienieneeneecieeceeieeieeennn 169
Applying the Grow and Similar commands...........cccceecveveerueenennee. 169
Saving and loading selections ...........ccoceevievienieneeniencinieeieeieene 170

Chapter 8: Working withLayers .....................ccvintnn. m

Getting to KNOW LAYEY'S ...cc.eoviiriiiiiiiieiieieciecie ettt sae e 171
Converting a background to alayer.........cccccevevvervieniieniieniienceennns 172
Anatomy of the Layers panel...........cccecevviirviiniiniiniinicnciceee, 173
Using the Layer and Select menus...........ccocceeveeveecieecieecieeeeeeeennn, 175

Working with Different Layer TYPes ........cccocevieiiieieneninieeeeeeeeene 177
IMAGE JAYETS...cuiiiieeiieciieieeeeeete ettt eeesaeebe e ebeesaesnnaas 177
AdJustment JaYErS......cccvevierienieiieiieeeieete et 178
Fill JAYEIS ...veiiiiiieietetcttee ettt ettt ettt st 180
ShapPe LAYET'S ..c.ueeviiiiieiieiieieceee ettt st 181
TYPE LAYETS .ottt ettt et e et re e ae e s e e ae e enseeens 182

Tackling Layer BaSICS .....c.ccveciieiiieiieeieciecieeeee ettt sve e 182
Creating a new layer from scratcCh..........cccoocvevivviiecincieniieeieeieeene 182
Using Layer via Copy and Layer via Cut ........ccoeceeveeciercincrenceennnen. 184
Duplicating layers ........ccccvereivieeiiniiiiierieeteseest e 184
Dragging and dropping layers..........cccocevveevienienennensenienieneeneens 184

Using the Paste into Selection command ...........ccccceeevveciieieeeennn. 185



Table of Contents iX

Moving a Layer’s COntent..........ccoeeeieieieninenieieeeiesieeceeeee e 186
Transforming LAYETS .......ccccveciiriieeiieeiieniesiesteseesieesteesieesteeeeseeseesaeesaeenes 187
Adding Layer MasKS .......ccceeiiriiinieiieniiniesieetestene e sie e etessessesnesanens 188
Flattening and Merging Layers........ccccecuevierieneeneenenrienienieseeseeseeneeenne 190
Flattening layers.......ccocoviiviineeiiniiiiieetetceet e 191
MeErGING LAYEYS......oiieieieiieeieeete et ettt e evee e esereesae e s b e e ssaeeeseeens 192
Chapter 9: Simple Image Makeovers ........................... 193
Cropping and Straightening Images ..........cccceeeveeciiecieecieeiecieceeceeeeeeeene 193
Cutting away with the Crop tool........cccoceevieiiiiininineeeeee, 193
Cropping with a selection border.............cccceveevieeciieciiecieeieeeeeen, 196
Straightening iIMages ........ccceveeviirriiiiinieceee e 196
Recomposing IMAgES .......cccevviiriiriiniiiieeececee e 198
Employing One-Step Auto FiXes......cccoovvriiniiniiniiiiieeeceeeeeeeeeeee 200
Auto Smart TONE ......cocoveiririiineeeercre et 200

AUto SMArt FiX..ooooiiiieeieieeeeee e 201

AULO LEVEIS .ttt 202

AUtO CONLIaST ..c.eeuiiiiiiiree et 203

Auto Color COrTeCtion......ccoeeveiriiiiinieeieeieete ettt 203

AUtO Sharpen.......ccooociiiiieceee e e 204

AUto REA EYe FiX...oooviiiiiiieiieeeeeeeeeeeee ettt 205
Editing in QUIiCK MOdE........ccccciiiiiieieeieciecteeeee et sae e 206
Fixing Small Imperfections with TOOIS..........cccceevieiieieeiieeiecieceeeeeeee 210
Cloning with the Clone Stamp tool..........ccccceevivverviinciiniinierieen, 210
Retouching with the Healing Brush..........cccccoovvvniininiiniinnininnn. 212
Zeroing in with the Spot Healing Brush .........c.cccocovciniininnnnnne. 214
Repositioning with the Content-Aware Move tool..............ccc.c...... 216
Lightening and darkening with Dodge and Burn tools.................. 217
Smudging away rough SpPOotS.........cccecueevieriiiieniereeceeeeeee e 219
Softening with the BIur tool..........c.cceevieniiniiniieiceeeee 221
Focusing with the Sharpen tool .........c.ccooceviiniiniininiiiieeiee 221
Sponging color on and Off ...........ccccovveriieniiiniiiniineen 223
Replacing one color with another ...........c.cccoeviiiiiiiiciencieeeeeee 224
Chapter 10: Correcting Contrast, Color, and Clarity............... 221
Editing Your Photos Using a Logical Workflow ...........ccccceevivviinnnnnnnen. 228
Adjusting LIghting .........oooveiiiiiiiieecececeeeeeee e 228
Fixing lighting with Shadows/Highlights.........c.ccccccceeiniinniennnnnnnn. 229
Using Brightness/Contrast..........ccccoeevvienienienienieneeeeeeieeeeeeens 230
Pinpointing proper contrast with Levels.........cccccocvviriinnennnnnnn. 230
AdJuSting COlOT ..couuiiiiiiiiiiiiieiteeeeeeee ettt 233
Removing color casts automatically .........cccceccvvreciiiniiencienineen, 234
Adjusting with Hue/Saturation............cccceceveiininininiieneneneeee 235
Eliminating color with Remove Color .........cccccevvevieciinciinieeiennn, 236

Switching colors with Replace Color.........ccccoevvevieninciniiincieniennnn, 238



X Photoshop Elements 13 For Dummies

Correcting with Color CUrves..........cccecuveviieviieiieeceeecieeieeeeeeeeee e 239
Adjusting SKiN tONES .......cceecieviieiieiieieeieee et 241
Defringing IaYers .......cccuevierieriieiieiecieciee ettt aeeae e 242
Adjusting color temperature with photo filters...........ccccoeuenenee. 244
MapPing YOUI COLOTS ...c.coviiriiriiiniieiieiecieeeeie ettt sne s 245
AdJusting Clarity .....cocceeieeeerieniiiieeeeieee ettt st 246
Removing noise, artifacts, dust, and scratches............ccccecuvennen. 247
Blurring when you need to .........coceecveeieeienienieceeceeieeeeveeee s 248
Sharpening for better foCus.........cccovvveevieeieniinieeeceeeeeeeeee 251
Working Intelligently with the Smart Brush Tools..........ccccceeuvrvennennnn. 254

Part IU: Exploring YVour Inner Artist...........cceeeeeeeeeeecee. 259

Chapter 11: Playing with Filters, Effects, Styles, and More......... 261
Having Fun with Filters ..........cooooiiiieiiiieeceeeeceeeeee e 262
APPLYING fIIEEYS ..ottt 262
Corrective or destructive filters ........ccccoceeveviivenennininncncncee, 263
One-step or multistep filters..........cccoevieiiiicciiiccieeeee e 263
Fading a filter.....cccooviiriiiiiieee et 264
Selectively applying a filter...........ccoceevveeienienieeeeceee e 264
Working in the Filter Gallery .........cccoceeveviiinineniininieeeeeeeeene 265
Distorting with the Liquify filter.......c.cccoevvevviiniiniiieiceeieeeee 267
Correcting Camera DiStOrtion...........ccecvevueecieeniinnieniienieniesieseeseeseeseenne 269
Exploring Element’s Unique Filters ........ccccocvvivviiniinnenieniiinienienceneene 271
Creating @ COMIC .....uovviiiiinienieieteeeeee ettt 272
Getting graphiC.......ccoociieiieieiececeee e 273
Using the Pen and Ink filter...........ccooiiininiiiioiiieeeeee 274
Dressing Up with Photo and Text Effects.........cccccoovivviecienciniinieeieees 275
Adding Shadows, Glows, and MOTe.........c.cccecuevierienieneenieeieeieevesnenenens 277
ApPlying layer StYles ......ccoviiviiiiiiiiiiieiecieeeceeee e 277
Working with layer styles ........ccccovivviriiniiniinienicteeceeeeee, 279
Mixing It Up with Blend Modes..........cccceeeiiieiieieeiecceeeeeeee e 280
General blend modes.........c.coeeiriiiiinenineeeeee e 280
Darken blend modes..........cccooeeerieienienininieieieseneseete e 281
Lighten blend modes..........ccooeeviiviiiiiniiinienieeeeeeeeee e 282
Lighting blend modes...........coceeviriiiiiiniieniinieteeceeeee et 283
Inverter blend MOdES..........cocceeviiriiriiiniiinieieteeceee e 284

HSL blend mModes ..........cocouevireneninenieininieteeeeseeesie e nens 285
Using PhOTOMEIGE .....c..ooiiiiiiiiiieeeeeteeeteeetee et 286
Photomerge Panorama............cccceecueeieeieeieneeneeneeseeieecreeveeaeeenens 286
Photomerge Group Shot .........ccccevviiiiiniienienieeeececeeeeee e 289
Photomerge Scene Cleaner...........cccocevueeienienieneeniensieniesieeeennens 291
Photomerge EXposSure.........cccccocevviiiiinieniinienieeceeeseeeeeeeeeenn 292

Photomerge COMPOSE........c.ccoueeevieiieiieieeieceeseeee e reeae e 295



Table of Contents
Chapter 12: Drawing and Painting ............................. 299
ChoOSING COLOT ..ottt ettt e e s e e aeesaeenee 299
Working with the Color Picker ..........cccocoevviiviiiniiniiniinicccieeenee, 300
Dipping into the Color Swatches panel.........c.cccoceevvevvirvinvienceennnnn. 301
Sampling with the Eyedropper tool..........cccccocvviiviniiniiniienienenn. 303
Getting Artsy with the Pencil and Brush Tools .........c.ccccocevivienieneennennns 304
Drawing with the Pencil tool ........c..cccooeveeieniinieieececececee 304
Painting with the Brush tool.........c..cccoevvieieniiniiieeccececeee 306
Using the Impressionist Brush.........c.ccccoecievviiniininninininieeiene 307
Creating your own brush ........ccccoecevviiniiiinniinineceeeeeeenn 309
Filling and Outlining Selections ..........cccccoueriiniiiiiniinnienienieneeeeeneeeee 310
Fill "€F UD cetiiicieeeeeeeeee ettt e 310
Outlining with the Stroke command...........c.cccceevueeviinciiecieeieeiennen, 311
Splashing on Color with the Paint Bucket Tool...........cccceeeeiinienvenenns 312
Working with Multicolored Gradients ...........ccoceeverieneenennensieniieniennene 313
Applying a preset gradient ..........cocceevveevieniiiniiiniiinieneeeeeee e 313
Customizing gradients.........c.cceceeeveviererienerceeeeereseeeeeeeee e 315
Working with Patterns ...........coccviiiiieiiiciirceecceeeeeeee e 317
Applying a preset pattern.........cccoceevieecieeciieiieieceeceee e 318
Creating a NEW PatterN.......ccccecieiieiieiieieeeese et 318
Creating Shapes of All SOItS ........ccceiiiriiiieiieiiciecee e 319
Drawing @ ShaPe€.......ccoocieviiiiiiniieiieienierretct et 320
Drawing multiple Shapes ........ccccocirviiriiiniiiniienieecneeeeeeeenn 321
Specifying Geometry Options ...........cceecveeeereenieneeseeie e 321
Editing Shapes .......cccveiieiieeeeceee ettt 323
Chapter 13: WorkingwithType ...t 325
Understanding Type BasiCs ........cocceeveeriiniiniiniiiiiieeeeeeceeceeeseeeee 325
4 1o Yo) L3RRS 326
IMIOAES ...ttt ee st eetae s e eeabae e s senbaeeeene 326
FOIMALS ..ot 327
Creating Point TYPe......cociviiriiniieeiteieeeeeee ettt 327
Creating Paragraph TYPe.......cooveeuieiiieiiieiiececie et 329
Creating Path TyPe.....cocoi i 330
Using the Text On Selection tool ...........cccceevveviineenencencieeieeieene 330
Using the Text On Shape tool.........cccceevveviinieniineeneeeeeeeeeeene 331
Using the Text On Custom Path tool.........c.ccoceoviiviiiiniinniininn. 333
Specifying Type OPtiONS......coccevvieriieriienieniierieeceeeeeeee sttt 333
Editing TeXE ...oocuiieeieiieeeeeeeee ettt te et e reere e saa e s e e saeereanns 336
SIMPHEYING TYPE .ottt s 337
Masking With TYPE ...ccviviiiiiiieieeeeeteeeeee ettt 338
Stylizing and Warping TYPE .....cccvevveeieriiiienieneeieeieeieete et saeenee 340
Adjusting type OpaCItY .....coovevueriiiiiiiieeieeeceee e 340
Applying filters to YOUr tyPe ....cccoceevievcierieniiriereeteeeeeeeeen 340
Painting your type with color and gradients............c.ccccceeeeuerennnn. 341

Warping YOUT tYPE.....ccvirierieriieiieitieiteeieeieeteertesreesreesseesseesseesesnnas 342

Xi



X’ii Photoshop Elements 13 For Dummies

Part U: Printing, Creating, and Sharing...................... 345

Chapter 14: Getting ltonPaper .......................cooiat. 347
Getting Pictures Ready for Printing ..........ccccecevviievieienieniicieceeeeeeens 348
Working with Color Printer Profiles..........ccccccoevieviiniinieninciieiecieeieene 349

Printing a photo with the printer managing color....................... 350
Printing a photo with Elements managing color.............cccceenee. 356
Printing a picture package or contact sheet .........ccccccoeevveveennennenn. 358
Getting Familiar with the Print Dialog BoX.........cccccevevininininniiieene. 360
USING PAage SEtUP...ccveviiiieiieeeiece ettt 362
Creating transfers, borders, and more with More Options.......... 362

Chapter 15: Sharing YourWork ............... ...t 363

Getting Familiar with the Elements Sharing Options..........c.ccecvevvenennne 363
Planning ahead.........cocoviiniinieiiniiiiecetceee e 364
Understanding photo sharing in Elements..........cccccccovvvnviennnncen. 365

Working with Adobe Revel ... 366
Knowing what Adobe Revel offers you..........ccccoeeverernievenenennnne 367
Downloading the Adobe Revel applications...........ccccceeveecveevennn. 367
Understanding the Adobe Revel interface..........ccccccecvvveririennennn. 368
Editing a photo with Adobe Revel...........cccocovivniininiiniiniinienn, 368
Sharing photos with Adobe Revel .........ccccocvviiniininiiniinienienene 371
Downloading images from Adobe Revel............cccoevvieciecennnene 371

Using the Share Panel ..o 372
Emailing pPhotos ........oocooviiiiieiieecceceee e 373
Working with Adobe Premiere Elements.........c.cccccecvevveniiniennennen. 375
Sharing your photos on social networks..........c.cceecevcvrvirvienciennnnn. 375

Chapter 16: Making Creations ..................ccooviiinnnnnn, 3719
Checking Out the Create Panel...........ccooeeviieviniiniiniinieieeeeeeeee 379
Creating Facebook Cover Images ..........cooevvuerviiriiiniieniienienieneeseeseeneenne 380
Grasping Creation-Assembly BasiCs .......cccccceeuiiviiiciiecieciecieceeceeeeeieene 382
Creating a SHAe SNOW........ccooviiriiiiieeeeee e 386
Creating a PDF Slid€ ShOW.......ccccccoieiiiiiiieiieiicieeiecteeteeee st 388
Making Additional Creations ...........ccceeveevieeieniiinienieseeseese e esie e 389

Part Vl: The Part of Tens .......cccccceeeceeccaaaaannnneneeeeeeeees 391

Chapter 17: Ten Tips for Composing Better Photos............... 393
Find a FOcal POINt ......ccooviiiiiiee e 393
Use the Rule of Thirds ........ccccoviriniiiiieieeeeeeeee e 394

CUL ThE CIULLEY .ottt eenes 394



Table of Contents ~ X[[[

Frame YOUY SOt .....cvoiiiiieiicieeeeeeeeeeetee et ae e 395
EmMPIOY CONIast ....ccoouieeirieieieiieee ettt 395
Experiment with VIEWPOINtS .....c.ccceeiiiiiiiiiiiececceeece e 395
Use Leading LINES......cccccvieriiiiiiiiirieeienieeeestese et eie e eve st see e e saeeseeenes 396
USE LIGNT .uiieiiieeeeeeeee ettt ettt sae s e 396
GiVE DIFECHION ..c.eevieieeieeeee et eabeeen 397
Consider Direction of MOVEMENL ...........ccceecuieciieciieieeieeieceeeee e 398
Chapter 18: Ten More Projectldeas............................ 399
SCIEEI SAVETS ....eeuvievieiieieeieeteeteeteetestestee s e esseesteeseesaessesssesssessaesssenseanes 399
Flyers, Ads, and Online AUCIONS..........ccecveeieeieriieiiesieeie e 400
Clothes, Hats, and MOYE ........coocveeiiiieiieieieeeeeeeee et 402
POSEEYS ...ttt et et aaeas 402
Household and Business Inventories............cccccoevevieeiiieecirccieecieeeeeeen, 402
Project Documentation...........ccocevvierieniiniinieneeieeeeeeeeeee st 403
School Reports and Projects.........cccccecveeeeeieneeciiesieceeeeeee e 403
BlOZS . ittt ettt e ta b e e besra e s e e naeenaeanes 403
Walit — There’s MOTE .........ooouiiiiiieiieeeeeeeeee ettt eeans 403

L (. Y 1/



XI(/ Photoshop Elements 13 For Dummies




Introduction

W live in a photo world. And Photoshop Elements has become a tool for
both professional and amateur photographers who want to edit, improve,
manage, manipulate, and organize photos and other media. Considering the
power and impressive features of the program, Elements remains one of the best
values for your money among computer software applications.

About This Book

This book is an effort to provide as much of a comprehensive view of a wildly
feature-rich program as we can. Additionally, this book is written for a cross-
platform audience. If you're a Macintosh user, you'll find all you need to work
in Elements 13 for the Macintosh, including support for placing photos on
maps and more consistency with Windows features.

As each software product is upgraded to a newer version, you sometimes
find a whole bunch of new features that dazzle you and sometimes you find
not so many new features but much more improved performance. Photoshop
Elements 13 is focused on the latter. You find some new and interesting fea-
tures such as a few more Guided Edits, a completely new Slideshow tool, a
Facebook Profile Creator, Selection Editing, more 16-bit support, Crop sug-
gestions, and Photomerge Compose. However the real power in Photoshop
Elements 13 is under the hood and features you don’t see such as much
improved performance and support for Windows 64-bit operating systems.

Because Photoshop Elements has something for just about everyone, we
know that our audience is large and also that not everyone will use every
tool, command, or method we describe. We offer many cross-references
throughout in case you want to jump around. You can go to just about any
chapter and start reading. If a concept needs more explanation, we point you
in the right direction for getting some background.

Throughout this book, especially in step lists, we point you to menus for key-
board commands. For accessing a menu command, you may see something
like this:

Choose File=>Get Photos=>From Files and Folders.
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You click the File menu to open its drop-down menu, click the menu command
labeled Get Photos, and then choose the command From Files and Folders from
the submenu that appears. It’s that simple.

We also refer to context menus, which jump up at your cursor position and
shows you a menu of options related to whatever you're doing at the time.
To open a context menu, just right-click the mouse, or Control-click on a
Macintosh if you don’t have a two-button mouse.

When we mention that keys need to be pressed on your keyboard, the text
looks like this:

Press Alt+Shift+Ctrl+S (Option+Shift+38+S on the Macintosh).

In this case, you hold down the Alt key on Windows/the Option key on the
Macintosh, then the Shift key, then the Control key on Windows/the 38 key
on the Macintosh, and then press the S key. Then, release all the keys at the
same time.

lcons Used in This Book

CRTURe

In the margins throughout this book, you see icons indicating that something
is important.

This icon informs you that this item is a new feature in Photoshop
Elements 13.

Pay particular attention when you see the Warning icon. This icon indicates
possible side-effects or damage to your image that you might encounter
when performing certain operations in Elements.

This icon is a heads-up for something you may want to commit to memory.
Usually, it tells you about a shortcut for a repetitive task, where remembering a
procedure can save you time.

A Tip tells you about an alternative method for a procedure, giving you a
shortcut, a workaround, or some other type of helpful information.
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This icon points out online articles that expand on a topic in this book. To
find all this great extra content, point your browser to www.dummies.com/
extras/photoshopelements

web
extras

Elements is a computer program, after all. No matter how hard we try to sim-
plify our explanation of features, we can’t entirely avoid some technical infor-
mation. If a topic is a little on the technical side, we use this icon to alert you
that we’re moving into a complex subject. You won’t see many of these icons in
the book because we try our best to give you the details in nontechnical terms.

Beyond the Book

We have online content that you can enjoy in conjunction with this book:

1 Cheat Sheet: The cheat sheet for this book includes a detailed look at
the Elements photo editing workspace, Tool Panel shortcuts, and tricks
for selecting objects, and more.

www .dummies.com/cheatsheet/photoshopelements

+~ Online articles: We couldn’t fit everything we wanted into this book, so
you can find additional content here:

www.dummies.com/extras/photoshopelements

A few of the topics covered are organizing and importing photos, dynam-
ically updating saved searches, finding and loading actions, and adjust-
ing brightness/contrast with the Smart Brush tool. But there’s much
more than these few topics. Be sure to check these out.

Where to Go from Here

Try to spend a little time reading through the three chapters in Part I. After
you know how to edit and save photos, feel free to jump around and pay
special attention to the cross-referenced chapters, in case you get stuck on

a concept. After exploring Elements’ Photo Editor look over Part I, where

we talk about organizing and searching photos. If you're ready to jump into
more advanced tasks, check out Parts IIl and IV, where you learn how to make
selections; layer images and effects together; add filters and type; and much
much more.

We hope you have much success and enjoyment in using Adobe Photoshop
Elements 13, and it’s our sincere wish that the pages ahead provide you with
an informative and helpful view of the program.


http://www.dummies.com/extras/photoshopelements
http://www.dummies.com/extras/photoshopelements
http://www.dummies.com/cheatsheet/photoshopelements
http://www.dummies.com/extras/photoshopelements
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In this part . . .

Open the Photo Editor and make quick and easy edits to one of
your photos in Quick mode.

Choose the right resolution for your image.
Select the best file format when you save your image.

Tour the Photo Editor interface so that you know how to switch
among images and navigate the many panels and options.
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Getting Started with Image Editing

In This Chapter
Starting the Photo Editor
Opening, editing, sharing, and saving a photo
Creating a new document
Using Undo History
Finding help

Saving your files

’ mage editing is incredibly fun, especially with a tool like Photoshop
Elements, which enables you to modify, combine, and even draw your
own images to your imagination’s content. To get the most out of Elements,
you need to understand some basic technical concepts, but like most
people, you probably want to jump in, play around, and basi-
cally just get started right away.

You’re in luck: In Quick mode, Elements helps you
make basic edits to your photos, like revealing your
child’s face darkened by a baseball cap’s shadow or
cropping out the gigantic trash can on the left edge
of your otherwise perfect landscape shot. In this
chapter, we help you jumpstart your image-editing
skills by guiding you through Quick mode and how
to share photos online, retracing your steps, saving
your edits, and more.

Launching the Photo Editor

Photoshop Elements has two separate components:

1~ The Organizer is where you manage photos. It’s full of tools for tagging,
rating, sorting, and finding your images. Part Il helps you start using the
Organizer.
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1~ The Photo Editor is where you correct photos for brightness and color,
add effects, repair images, and so on.

In this chapter, you work in the Photo Editor to make basic edits to a photo.
Here’s how to start Elements and open the Photo Editor:

1. Double-click the Photoshop Elements shortcut on your desktop or
in your Applications folder (Mac) to launch the Elements Welcome
screen.

Note: You have two buttons on the Welcome screen. The first button is
Organizer. The other button is Photo Editor.

2. Click the Photo Editor button shown in the Welcome screen in
Figure 1-1.

The Photo Editor workspace loads and appears, as shown in Figure 1-2.
By default, you see the Quick tab selected at the top of the Photo Editor
workspace, which means you’re in Quick mode (or right where you want
to be for the purposes of this chapter). Quick mode offers a limited
number of tools for adjusting brightness, contrast, color, and sharpness.

adobe photoshop elements 13 £ x

Organizer Photo Editor

Organize, find, and view all your photos. Edit, enhance, and add effects to your photos.

Figure 1-1: The Photoshop Elements Welcome screen.

When you first launch Photoshop Elements, you may see the eLive tab open.
Click the Quick tab to see the editing options for Quick mode. See the section,
“Getting a Helping Hand,” later in this chapter for more about eLive.
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Figure 1-2: The Quick tab is selected.

On the right side of the workspace, you see the Adjustments panel docked
in an area dubbed the Panel Bin. When in any one of the three editing modes
(Quick, Guided, Expert), you find different panels. On the left side of the
workspace, you see a Tools panel. Interacting with the items in the Panel
Bin and using tools in the Tools panel provides you an enormous number of
options for editing, improving, and stylizing your pictures.

Making Basic Edits in Quick Mode

For beginning users, the Quick mode in the Photo Editor is both powerful and
easy to use. Follow these steps to make some simple changes to an image:

1. Open the Photo Editor and make sure the Quick tab is selected at
the top.
2. Choose File~>Open.

If Elements is your default editing application, you can also double-click
your photo file in Windows Explorer or the Mac Finder, and the file
opens in Elements.
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3. In the Open dialog box that appears, navigate your hard drive to
locate the file you want to open, select the file, and click Open.

4. From the View drop-down list (in the upper left of the image window),
choose Before & After — Horizontal, as shown in Figure 1-3.

& Fie Edit Image

Open -

View: | Before & After - Horizontal +

Create - Share -

Adjustments a@

Smart Fix v
Exposure N
E_]

'““ Levels v

] Color

-
m Balance v
m Sharpen T

@ o

FHCAN

2 m» 9O O D HE = oM B O

Phot Bin | Tool Options | Undo. Redo Romate  Organizer ji Effects  Textures Frames

Figure 1-3: The before and after views in Quick mode.

5. Make edits to your photo.
Here’s an introduction to two simple edits you can make in Quick mode:

e Apply a Smart Fix: Click Smart Fix in the Panel Bin to see the
options. To begin with, click Auto at the bottom of the Smart
Fix panel and select the After view to see whether you like the
changes.
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Open -

As shown in Figure 1-3, several items are listed in the Panel Bin
below the Smart Fix option. Click an item to expand it and move
the sliders, or click the thumbnail images to tweak the overall
brightness, contrast, and color. In many cases there isn’t a right or
wrong adjustment. Play with the options to bring it close to your
overall vision for the picture. For a more in-depth look at correcting
photos in Quick mode, flip to Chapter 10.

e Crop the photo: In the Tools panel on the left side of the window, click

the Crop tool. You immediately see a rectangle on top of the photo.
Move the sides to crop the image to your liking. When finished, click
the green check mark, as shown in Figure 1-4, to accept your edit.

When making any one of a huge number of edits to your pictures,
you often see icons on top of the image similar to what’s shown in
Figure 1-4. The green check mark accepts the edit you’re making at
the time the icons appear. The circle with a diagonal line is the
Cancel button. Click this button when you don’t want to apply the
recent edit.
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Figure 1-4: The Crop tool sized on a photo.
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6. Choose File=>Save As and, in the Save As dialog box that opens, pro-
vide a new name for the photo. Click Save.

Note: When you use Save As and give your image a new name, you don’t
destroy your original image. You save a copy of the original with the new
edits applied. For more on saving files, see the section “Saving Files with
Purpose” later in this chapter.

Sharing a Photo

After you edit your photo, you can print the photo to share with family and
friends or post the photo on a social network.

Because sharing photos on social networks is extremely popular, we intro-
duce you to the Elements sharing features with the following steps, which
explain how you can use Elements to share your photo on Facebook:

1. Prepare the photo you want to upload to Facebook.

Typically, digital cameras take photos sized very large — too large for
an image that your friends and family will want to download quickly and
view via Facebook on a computer screen or a mobile device. To adjust
your image so it’s the right size and resolution for viewing online, follow
these steps:

a. Choose Imager>Resizer>Image Size.

b. In the Image Size dialog box that appears, enter your desired width
(or height).

Either Width or Height is fine because the image will maintain
correct proportions by choosing either. A width between 6 and
8 inches works well. Click the Pixels drop-down menu next to
Width to choose Inches as your unit of measure.

c. Type 144 in the Resolution box. For screen viewing only 72 ppi is
fine. However if you want your friends to print the image, 144 is a
better choice. You can use either resolution.

d. Select the Resample Image check box and then click OK (see
Figure 1-5).

The image is sized to a workable size for Facebook. In Chapter 2, you
take a closer look at what these image-sizing options mean and how
to choose the right settings for your prints or online images.
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Figure 1-5: Resize an image in the Image Size dialog box.

. Choose File=>Save As~>JPEG to save the file as a JPEG.

Note the location where you save the file on your hard drive. Chapter 2
also explains how to choose the right file format for your images. (JPEG
is one of many file formats that Elements supports.)

. Click Share in the top-right corner of the workspace to open the Share
panel and then choose Facebook from the drop-down list.

Elements enables you to upload to other services, like Twitter and Flickr,
too. For details about the Share panel, flip to Chapter 15.

. Authenticate your account.

A dialog box opens when you choose Facebook in the Share panel,
prompting you to authenticate your account. To authenticate your
account:

a. Click Authenticate in the dialog box.
b. Fill in the text boxes for your Facebook login and password.

Your authentication is complete.



’4 Part I: Getting Started with Photoshop Elements 13

5. Click the Upload button to upload the file.

When the file upload is complete, a dialog box opens and prompts you
to view the uploaded file.

6. Click Visit Facebook.

Your photo is added to your Facebook account, as shown in Figure 1-6.

@ [ @ nttpsy/fwww facebookcom/tedpadova O + @ & || @ (21Ted Padova ‘ ‘

Oberon, New South Wales

1 don't have a hometown

@ Public ~ m Skip

ABOUT

Author (Computer Books) at Self-Employed
Lives in Davao City

PHOTOS - 19

@ Tag more photos

Figure 1-6: An edited photo uploaded to Facebook.

Creating lmages from Scratch

You may want to start from scratch by creating a new document in Elements.
New, blank pages have a number of uses:
»* Mix and merge images in a new document, as we explain in Chapter 8.
1 Create a canvas where you can draw and paint, as we explain in Chapter 12.
1 Use the New dialog box to find out a file’s size, dimensions, and resolu-
tion. You find out why these details are important in Chapter 2.

Follow these steps to create a new document while working in any editing
mode:

1. In the Elements Photo Editor, choose File>Newr>Blank File or press
Ctrl+N (38+N on the Mac).



